
r Solutions Guide
December 17, 1999



doc_tpl.fm Rev 99a 28 October 99
Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

This product may require export authorization from the U.S. Department of Commerce prior to exporting from the 
U.S. or Canada.

Copyright © 1993-2000 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

U.S. Patent Nos. 4,555,775; 5,157,663; 5,349,642; 5,455,932; 5,553,139; 5,553,143; 5,594,863; 5,608,903; 
5,633,931; 5,652,854; 5,671,414; 5,677,851; 5,692,129; 5,758,069; 5,758,344; 5,761,499; 5,781,724; 5,781,733; 
5,784,560; 5,787,439; 5,818,936; 5,828,882; 5,832,275; 5,832,483; 5,832,487; 5,859,978; 5,870,739; 5,873,079; 
5,878,415; 5,884,304; 5,893,118; 5,903,650; 5,905,860; 5,913,025; 5,915,253; 5,925,108; 5,933,503; 5,933,826; 
5,946,467; 5,956,718; 5,974,474. U.S. and Foreign Patents Pending.

Novell, Inc.
122 East 1700 South
Provo, UT 84606
U.S.A.

www.novell.com

User Solutions Guide
January 2000
104-001218-001

Online Documentation: To access the online documentation for this and other Novell products, and to get 
updates, see www.novell.com/documentation.
User Solutions Guide
104-001218-001

December 17, 1999
Novell Confidential



doc_tpl.fm Rev 99a 28 October 99
Novell Trademarks

For a list of Novell trademarks, see the final appendix of this book.

Third-Party Trademarks

All third-party trademarks are the property of their respective owners.
User Solutions Guide
104-001218-001

December 17, 1999
Novell Confidential



doc_tpl.fm Rev 99a 28 October 99
User Solutions Guide
104-001218-001

December 17, 1999
Novell Confidential



doc_tpl.fm Rev 99a 28 October 99
Contents

Overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  7

�� User Solutions for NetWare 5.1   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9

Web Publishing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9
Using Web Folders .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  10
Creating Your Own Web Site .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  12
Accessing and Managing Files on Web Servers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  12
Using the My Network Folder.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  13
Using FTP to Transfer Files to Your Web Server.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  14

Participating in Newsgroups  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  15
Accessing the NetWare News Server   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  15
Participating in Newsgroup Discussions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  17

Searching Your Intranet  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  18
Using the NetWare Enterprise Web Server Search Engine   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  18
Using the NetWare Web Search Server  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  18

Participating in Audio and Visual Network Broadcasts.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  20

$$ Novell Trademarks .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  21
Contents �

User Solutions Guide
104-001218-001

December 17, 1999
Novell Confidential



doc_tpl.fm Rev 99a 28 October 99
� User Solutions Guide

User Solutions Guide
104-001218-001

December 17, 1999
Novell Confidential



doc_tpl.fm Rev 99a1 7 28 October 99
Overview

NetWare® 5.1 is more than a back-end service for file storage and networked 
applications. You can also use it to increase productivity, to communicate 
more effectively, and to take advantage of the software and services offered 
on your network. In addition, using NetWare 5.1 in conjunction with 
Microsoft* Office 2000 makes publishing and collaborating on intranet or 
Internet documents simple and intuitive.
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� User Solutions for NetWare 5.1

NetWare® 5.1 allows you to take advantage of Microsoft* Office 2000 
features that require back-end services, which includes Web-based services on 
the network. NetWare 5.1 also makes it easy for users to take advantage of 
company hosted resources and even to create their own Web presence.

Web Publishing

A corporate Web site, or intranet, allows users or departments to publish 
information and make it available to the entire organization. Traditionally, the 
task of publishing information to a Web site was tedious, time-consuming, and 
primarily for those more technically inclined. But with NetWare 5.1 and 
Office 2000, anyone can create and publish information, transforming the 
Web into a central work environment for real-time collaboration and 
communication.

When you install Office 2000 Web Publishing, an object named Web Folders 
is added to the Microsoft Windows* environment. In Windows NT* 4.0 and 
Windows 95/98, Web Folders appears immediately after My Computer in the 
Windows Explorer hierarchical structure.

The Web Folders object contains shortcuts to Web sites. You can create, 
move, rename, and delete shortcuts in Web Folders. The shortcuts you add can 
include both a URL and a display name. In Windows Explorer, you can 
publish by dragging files to sites in Web Folders.

In Office 2000 applications, Web Folders gives you access to Web sites from 
My Computer, Windows Explorer, and the Open and Save As dialog boxes 
accessed from the File menu. With the Web Folders object installed, you can 
navigate within, open files from, and save files to Web sites.
User Solutions for NetWare 5.1 �
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Publishing content to an intranet is as easy as saving documents to a regular 
network file server. Office 2000 provides quick access to common publishing 
locations on your intranet through Web folders—shortcuts to Web servers that 
you create from your PC. You can easily add Web folders while working in 
any Office 2000 application through improved Open and Save options. 

Using Web Folders

Web Folders is displayed under My Computer or in the left pane of Windows 
Explorer, at the same level as your local and mapped drives. Since they can be 
accessed like a drive, you can perform the same functions to a Web folder that 
you can to a drive. This includes creating directories, viewing document 
properties, and performing drag-and-drop file operations.

In Microsoft Office applications, the Open and Save As dialog boxes accessed 
from the File menu support Web Folders. This allows Office users to open or 
save documents on Web sites as easily as they open and save documents on a 
hard disk.

To create a Web Folder shortcut:

�� Open Windows Explorer or My Computer.

�� Select the Web Folders icon.

�� Select the Add Web Folders wizard.

�� Enter a valid URL, for example,

http://IP address or domain name

�� Enter a shortcut name and login information.

Your Web Folders shortcut can be accessed by double-clicking the shortcut. 
Your Web site can be treated as a drive and the contents of your Web site will 
be displayed as you view the contents of any local or mapped drive. Your Web 
site can also become an alternative location for saving documents.
�� User Solutions Guide
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Figure 1 Web Folders in Windows Explorer

You can also quickly create a Web folder for an existing Web server location 
by typing the Web address in the File Name field of the Open or Save As 
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dialog box. Any Web server address you enter is added to your Web Folders 
list.

After you have created a Web folder, you can save HTML or Office 
documents to your Web server from any open Office 2000 application.

To publish a document to a Web server: 

�� In any open Office 2000 document, click File > Save as Web Page.

�� Click Web Folders in the Places bar.

�� From the list of Web folder sites, double-click the folder you want > 
double-click the location to which you want to save the Web page.

�� In the File Name field, type a name for your document > click Save.

When you save a Web page, all supporting files—such as bullets, background 
textures, and graphics—are automatically organized in a supporting folder. If 
you move or copy your Web page to another location, you will need to move 
the supporting folder so all links to your Web page remain intact.

Creating Your Own Web Site

If you are a user on a network with a NetWare 5.1 server and have your own 
user directory, you can create your own personal Web site. This requires no 
administrative interaction.

To create a personal Web page, do the following:

�� Create a PUBLIC_HTML directory in your personal directory.

�� Copy or create a Web page and place the INDEX.HTML file in this 
directory.

�� Access the Web site by entering the following in your browser:

http://server name/~user name

or

http://IP address/~user name

Accessing and Managing Files on Web Servers

Once you have published documents to a Web server, you and your 
workgroup can easily find, view, and manage them using the same file 
operations you are accustomed to performing on a local hard disk or network 
file server.
�� User Solutions Guide
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To open Web pages through Office 2000 programs:

�� Click File > click Open > click Web Folders (in the Places bar) > double-
click the Web folder containing the Web page you want to open.

�� From any application, click Open on the toolbar > enter the URL for the 
Web page you want to open.

�� In any open Office document displaying the Web toolbar, type the URL 
in the Address box.

To open Web pages through Windows Explorer, double-click the My 
Computer folder > Web Folders. You can then move, copy, rename, delete, 
and view properties for these folders and files as if they were on a regular file 
server. You can also drag and drop files between Web servers, between a Web 
server and a file server, or between a Web server and your hard disk.

Using the My Network Folder

The My Network folder provides a central location on your NetWare server 
from which you can access network resources. This folder is available to 
workstations running any client for Novell networks, with a Web connection, 
and with either Internet Explorer version 5 or with Web Folders. Unlike the 
Network Neighborhood folder in Windows, this folder actually exists on your 
NetWare server instead of your workstation. This folder is also accessed 
through standard Web protocols. Because of these qualities, you can access 
the My Network folder from any Windows workstation that is attached to the 
Internet—anywhere in the world, and no NetWare connection or Novell 
ClientTM is required.

Within the My Network folder, you will find your personalized version of the 
following items:

� Mapped Drive Web Folders

If your network administrator has set up mapped network drives for you 
that are normally visible at the client, you will be able to see those same 
directories as Web folders within the My Network folder. This will allow 
you to access your corporate applications and data remotely without the 
need for a Novell ClientTM on your workstation.

Windows and DOS applications that require traditional drive mappings 
will not work in this environment.

� Personal Web Publishing Folder
User Solutions for NetWare 5.1 ��
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When your login account was created on your Novell® network, your 
network administrator probably created a home directory (user directory) 
for you out on the network. This is typically mapped to drive F:\. To 
create your own personal Web site, follow the steps listed in “Creating 
Your Own Web Site” on page 12.

You can control who can access your Web publishing folder by dragging 
and dropping user and group objects from your NDS® directory Web 
folders onto those folders.

� My Directory Tree Web Folder

This folder allows you to see the contents of your NDS® tree. In 
particular, you can see the users and groups that have been defined within 
your network. To view the properties of any object that you can see within 
the tree, double click its icon within the Web folder.

Your network administrator will probably allow you to modify only the 
properties of your own user object and your personal Web publishing 
folders. The rights to other users, groups, and Web folders are controlled 
by the network administrator.

� My Organizational Unit Web Folder

Your organizational unit Web folder contains user objects that represent 
all of your colleagues in your department as well as any group objects of 
users that your network administrator may have defined. The users and 
groups you find within this folder will also include the special user 
objects: [public] and [nobody].

Use the user and group objects within this Web folder to modify the 
access rights on your Web folders or any other areas in which the network 
administrator has given you access control rights.

Using FTP to Transfer Files to Your Web Server

The File Transfer Protocol (FTP) provides a simple way to transfer files from 
your workstation to your Web server. NetWare 5.1 allows you to add, move, 
or delete files stored on a Web server just as easily as files stored on a hard 
disk.

There are three ways to use FTP to transfer files:

� Using the FTP command from the DOS prompt

� Using FTP from within your Web browser

� Using an FTP utility
�� User Solutions Guide
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All these methods are supported with NetWare 5.1, but also included is 
support for Web Folders. This is a new capability that allows you to save 
individual files directly to your Web server. This means that instead of having 
to save a file locally and then transfer that file to your Web server using FTP, 
you can now just save directly to a preconfigured FTP connection (your Web 
site) using Web Folders.

For more information on using Web Folders see “Using Web Folders” on page 
10.

Participating in Newsgroups

A newsgroup is a forum where users can share ideas, collaborate, post 
questions, and receive input from other users. The NetWare News Server can 
host newsgroups that users can participate in.

As an alternative to exchanging e-mail messages or routing documents 
through inter-departmental mail or faxes, NetWare News Server allow users 
to discuss information, plans, or ideas from your news reader, such as 
Microsoft Express. 

The NetWare News Server extends workgroup interactivity by organizing 
discussions by topics. This allows multiple departments working on different 
aspects of the same project to share ideas, show project status, answer 
questions, and so on.

Accessing the NetWare News Server

Ask your network administrator if the News Server has been installed and 
configured. You will need a news reader, which is included with Microsoft 
Outlook Express.

To access the News Server from Outlook Express:

�� Click Tools > Accounts.

�� Select the News tab > click Add > click News.

�� Enter the display name, which is what will appear in your list of 
newsgroups.

�� Enter your e-mail address, used for correspondence in news messages.

�� Enter the address of the News Server.
User Solutions for NetWare 5.1 ��
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This can be an IP address, the name of the server, or a public newsgroup 
address.

�� Specify logon information as required. 

�� Click Finish to display a list of all your newsgroup accounts. 

�� Click Close. 

You will be asked if you would like to download the newsgroups from the 
newly created account. 

�� Click Yes.

���� Subscribe to the desired groups by double-clicking the newsgroups you 
want to participate in.

���� Click OK to return to Outlook Express.

The following figure shows Outlook Express being used to access newsgroups 
hosted on a NetWare 5.1 server.
�� User Solutions Guide
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Figure 2 Outlook Express

Participating in Newsgroup Discussions

To participate in a newsgroup:

�� Open Outlook Express > click the news server you want to access.

News servers and groups are displayed in the left Folders pane. 

�� Click a message to view it in the bottom preview pane.
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�� Double-click the message to open it, access file attachments, or reply.

News reader programs have different features and capabilities, and NetWare 
News Server supports them. Contact your network administrator for access to 
your company’s newsgroups.

You can also access the Novell public newsgroups using forums.novell.com 
as the newsgroup address.

Searching Your Intranet

Trying to locate information published by another department on your intranet 
formerly required that you search each department’s site individually. 
NetWare 5.1 has changed that requirement. The NetWare Web Search Server 
allows you to search your entire intranet at once.

The NetWare Web Search Server compliments and extends the functionality 
of the search capabilities already present in NetWare Enterprise Web Server. 
The two search alternatives are described below.

Using the NetWare Enterprise Web Server Search Engine

The NetWare Enterprise Web Server search engine can search a single site. 
This is the type of search provided by all Web sites today. To search multiple 
sites, you must go to each site and execute a search on each one.

To search a single site, access the site’s search button, or enter the URL 
followed by /search. For example, enter http://www.novell.com/
search.

Using the NetWare Web Search Server

The NetWare Web Search Server allows you to search multiple sites with a 
single search query. This is an extremely valuable tool for searching an entire 
company’s intranet for a specific piece of information, saving the time and 
hassle of having to search each site individually.

To perform a search across multiple sites, point your browser to the URL 
where the default search template is stored (default is http://server 
name/novellsearch) and run a search query on the contents of the root 
Web directory. For example, enter http://www.novell.com/
novellsearch.

The following figure shows the default Web Search interface.
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Figure 3 The Default NetWare Web Search Interface

With either search tool, you can perform a simple or an advanced search.

Simple Search.  Enter the URL for the search form > type one or more words 
in the Search field > click Find.

Advanced Search.  For more precise searches, you can take advantage of 
search operators, search proximity, and wildcard capabilities. Search 
operators include AND, OR, NOT, plus exact phrase or same sentence 
operators. The search proximity allows you to search for two words within a 
specified proximity of each other.
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Participating in Audio and Visual Network Broadcasts

NetWare 5.1 supports multimedia feeds over networks. This means you can 
listen to audio and watch video feeds over the network. Or you can have 
computer-based tutorials for education, entertainment, or business purposes. 
The NetWare MultiMedia Server supports the following file formats:

� WAV – Windows Wave format sound file.

� MP3 – MPEG-1 layer III. One of the best compressed audio formats 
available.

� RM – RealAudio file extension. RealAudio is a common Internet audio 
and video format, which supports streaming and live Webcasts.

To play the multimedia files being broadcast on your network, you need to 
install the player software, RealPlayer G2. RealPlayer G2 is a free, 
downloadable utility from RealNetworks Inc. (http://www.real.com). To play 
MP3 files, you have to install DirectShow for RealPlayer (http://
bitcasting.com).

To play multimedia files from the server:

�� Launch RealPlayer G2 on the workstation.

�� Click File > Open Location.

�� Type the location of the multimedia file, as shown in the following 
example:

rtsp://server_name/cathay.rm

where server_name is the network name of the MultiMedia Server.

�� Click OK.

Similarly, you can also play WAV and MP3 files by specifying their path as 
shown above.
�� User Solutions Guide
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Client 32 is a trademark of Novell, Inc. 
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NetNotes is a registered trademark of Novell, Inc. in the United States and 
other countries. 

NetSync is a trademark of Novell, Inc. 

NetWare is a registered trademark of Novell, Inc. in the United States and 
other countries. 

NetWare 3270 CUT Workstation is a trademark of Novell, Inc. 

NetWare 3270 LAN Workstation is a trademark of Novell, Inc. 

NetWare 386 is a trademark of Novell, Inc. 

NetWare Access Server is a trademark of Novell, Inc. 

NetWare Access Services is a trademark of Novell, Inc. 

NetWare Application Manager is a trademark of Novell, Inc. 

NetWare Application Notes is a trademark of Novell, Inc. 

NetWare Asynchronous Communication Services and NACS are trademarks 
of Novell, Inc. 

NetWare Asynchronous Services Interface and NASI are trademarks of 
Novell, Inc. 

NetWare Aware is a trademark of Novell, Inc. 

NetWare Basic MHS is a trademark of Novell, Inc. 

NetWare BranchLink Router is a trademark of Novell, Inc. 

NetWare Care is a trademark of Novell, Inc. 

NetWare Communication Services Manager is a trademark of Novell, Inc. 

NetWare Connect is a registered trademark of Novell, Inc. in the United 
States. 

NetWare Core Protocol and NCP are trademarks of Novell, Inc. 

NetWare Distributed Management Services is a trademark of Novell, Inc. 

NetWare Document Management Services is a trademark of Novell, Inc. 

NetWare DOS Requester and NDR are trademarks of Novell, Inc. 

NetWare Enterprise Router is a trademark of Novell, Inc. 

NetWare Express is a registered service mark of Novell, Inc. in the United 
States and other countries. 

NetWare Global Messaging and NGM are trademarks of Novell, Inc. 

NetWare Global MHS is a trademark of Novell, Inc. 

NetWare HostPrint is a registered trademark of Novell, Inc. in the United 
States. 

NetWare IPX Router is a trademark of Novell, Inc. 

NetWare LANalyzer Agent is a trademark of Novell, Inc. 

NetWare Link Services Protocol and NLSP are trademarks of Novell, Inc. 
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NetWare Link/ATM is a trademark of Novell, Inc. 

NetWare Link/Frame Relay is a trademark of Novell, Inc. 

NetWare Link/PPP is a trademark of Novell, Inc. 

NetWare Link/X.25 is a trademark of Novell, Inc. 

NetWare Loadable Module and NLM are trademarks of Novell, Inc. 

NetWare LU6.2 is trademark of Novell, Inc. 

NetWare Management Agent is a trademark of Novell, Inc. 

NetWare Management System and NMS are trademarks of Novell, Inc. 

NetWare Message Handling Service and NetWare MHS are trademarks of 
Novell, Inc. 

NetWare MHS Mailslots is a registered trademark of Novell, Inc. in the United 
States and other countries. 

NetWare Mirrored Server Link and NMSL are trademarks of Novell, Inc. 

NetWare Mobile is a trademark of Novell, Inc. 

NetWare Mobile IPX is a trademark of Novell, Inc. 

NetWare MultiProtocol Router and NetWare MPR are trademarks of Novell, 
Inc. 

NetWare MultiProtocol Router Plus is a trademark of Novell, Inc. 

NetWare Name Service is trademark of Novell, Inc. 

NetWare Navigator is a trademark of Novell, Inc. 

NetWare Peripheral Architecture is a trademark of Novell, Inc. 

NetWare Print Server is a trademark of Novell, Inc. 

NetWare Ready is a trademark of Novell, Inc. 

NetWare Requester is a trademark of Novell, Inc. 

NetWare Runtime is a trademark of Novell, Inc. 

NetWare RX-Net is a trademark of Novell, Inc. 

NetWare SFT is a trademark of Novell, Inc. 

NetWare SFT III is a trademark of Novell, Inc. 

NetWare SNA Gateway is a trademark of Novell, Inc. 

NetWare SNA Links is a trademark of Novell, Inc. 

NetWare SQL is a trademark of Novell, Inc. 

NetWare Storage Management Services and NetWare SMS are trademarks of 
Novell, Inc. 

NetWare Telephony Services is a trademark of Novell, Inc. 

NetWare Tools is a trademark of Novell, Inc. 

NetWare UAM is a trademark of Novell, Inc. 

NetWare WAN Links is a trademark of Novell, Inc. 
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NetWare/IP is a trademark of Novell, Inc. 

NetWire is a registered service mark of Novell, Inc. in the United States and 
other countries. 

Network Navigator is a registered trademark of Novell, Inc. in the United 
States. 

Network Navigator - AutoPilot is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Network Navigator - Dispatcher is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Network Support Encyclopedia and NSE are trademarks of Novell, Inc. 

Network Support Encyclopedia Professional Volume and NSEPro are 
trademarks of Novell, Inc. 

NetWorld is a registered service mark of Novell, Inc. in the United States and 
other countries.

Novell is a service mark and a registered trademark of Novell, Inc. in the 
United States and other countries. 

Novell Alliance Partners Program is a collective mark of Novell, Inc. 

Novell Application Launcher is a trademark of Novell, Inc. 

Novell Authorized CNE is a trademark and service mark of Novell, Inc. 

Novell Authorized Education Center and NAEC are service marks of Novell, 
Inc. 

Novell Authorized Partner is a service mark of Novell, Inc. 

Novell Authorized Reseller is a service mark of Novell, Inc. 

Novell Authorized Service Center and NASC are service marks of Novell, 
Inc. 

Novell BorderManager is a trademark of Novell, Inc. 

Novell BorderManager FastCache is a trademark of Novell, Inc. 

Novell Client is a trademark of Novell, Inc. 

Novell Corporate Symbol is a trademark of Novell, Inc. 

Novell Customer Connections is a registered trademark of Novell, Inc. in the 
United States. 

Novell Directory Services and NDS are registered trademarks of Novell, Inc. 
in the United States and other countries. 

Novell Distributed Print Services is a trademark and NDPS is a registered 
trademark of Novell, Inc. in the United States and other countries. 

Novell ElectroText is a trademark of Novell, Inc. 

Novell Embedded Systems Technology is a registered trademark and NEST is 
a trademark of Novell, Inc. in the United States and other countries. 
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Novell Gold Authorized Reseller is a service mark of Novell, Inc. 

Novell Gold Partner is a service mark of Novell, Inc. 

Novell Labs is a trademark of Novell, Inc. 

Novell N-Design is a registered trademark of Novell, Inc. in the United States 
and other countries. 

Novell NE/2 is a trademark of Novell, Inc. 

Novell NE/2-32 is a trademark of Novell, Inc. 

Novell NE3200 is a trademark of Novell, Inc. 

Novell Network Registry is a service mark of Novell, Inc. 

Novell Platinum Partner is a service mark of Novell, Inc. 

Novell Press is a trademark of Novell, Inc. 

Novell Press Logo (teeth logo) is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Novell Replication Services is a trademark of Novell, Inc. 

Novell Research Reports is a trademark of Novell, Inc. 

Novell RX-Net/2 is a trademark of Novell, Inc. 

Novell Service Partner is a trademark of Novell, Inc. 

Novell Storage Services is a trademark of Novell, Inc. 

Novell Support Connection is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Novell Technical Services and NTS are service marks of Novell, Inc. 

Novell Technology Institute and NTI are registered service marks of Novell, 
Inc. in the United States and other countries. 

Novell Virtual Terminal and NVT are trademarks of Novell, Inc. 

Novell Web Server is a trademark of Novell, Inc. 

Novell World Wide is a trademark of Novell, Inc. 

NSE Online is a service mark of Novell, Inc. 

NTR2000 is a trademark of Novell, Inc. 

Nutcracker is a registered trademark of Novell, Inc. in the United States and 
other countries. 

OnLAN/LAP is a registered trademark of Novell, Inc. in the United States and 
other countries. 

OnLAN/PC is a registered trademark of Novell, Inc. in the United States and 
other countries.

Open Data-Link Interface and ODI are trademarks of Novell, Inc. 

Open Look is a registered trademark of Novell, Inc. in the United States and 
other countries. 
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Open Networking Platform is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Open Socket is a registered trademark of Novell, Inc. in the United States. 

Packet Burst is a trademark of Novell, Inc. 

PartnerNet is a registered  service mark of Novell, Inc. in the United States and 
other countries. 

PC Navigator is a trademark of Novell, Inc. 

PCOX is a registered trademark of Novell, Inc. in the United States and other 
countries. 

Perform3 is a trademark of Novell, Inc. 

Personal NetWare is a trademark of Novell, Inc. 

Pervasive Computing from Novell is a registered trademark of Novell, Inc. in 
the United States and other countries. 

Portable NetWare is a trademark of Novell, Inc. 

Presentation Master is a registered trademark of Novell, Inc. in the United 
States and other countries. 

Print Managing Agent is a trademark of Novell, Inc. 

Printer Agent is a trademark of Novell, Inc. 

QuickFinder is a trademark of Novell, Inc. 

Red Box is a trademark of Novell, Inc. 

Reference Software is a registered trademark of Novell, Inc. in the United 
States and other countries. 

Remote Console is a trademark of Novell, Inc. 

Remote MHS is a trademark of Novell, Inc. 

RX-Net is a trademark of Novell, Inc. 

RX-Net/2 is a trademark of Novell, Inc. 

ScanXpress is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Script Director is a registered trademark of Novell, Inc. in the United States 
and other countries. 

Sequenced Packet Exchange and SPX are trademarks of Novell, Inc. 

Service Response System is a trademark of Novell, Inc. 

Serving FTP is a trademark of Novell, Inc. 

SFT is a trademark of Novell, Inc. 

SFT III is a trademark of Novell, Inc. 

SoftSolutions is a registered trademark of SoftSolutions Technology 
Corporation, a wholly owned subsidiary of Novell, Inc. 
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Software Transformation, Inc. is a registered trademark of Software 
Transformation, Inc., a wholly owned subsidiary of Novell, Inc. 

SPX/IPX is a trademark of Novell, Inc. 

StarLink is a registered trademark of Novell, Inc. in the United States and 
other countries. 

Storage Management Services and SMS are trademarks of Novell, Inc. 

Technical Support Alliance and TSA are collective marks of Novell, Inc. 

The Fastest Way to Find the Right Word is a registered trademark of Novell, 
Inc. in the United States and other countries. 

The Novell Network Symbol is a trademark of Novell, Inc. 

Topology Specific Module and TSM are trademarks of Novell, Inc. 

Transaction Tracking System and TTS are trademarks of Novell, Inc. 

Universal Component System is a registered trademark of Novell, Inc. in the 
United States and other countries. 

Virtual Loadable Module and VLM are trademarks of Novell, Inc. 

Writer’s Workbench is a registered trademark of Novell, Inc. in the United 
States and other countries. 

Yes, It Runs with NetWare (logo) is a trademark of Novell, Inc. 

Yes, NetWare Tested and Approved (logo) is a trademark of Novell, Inc. 

ZENworks is a trademark of Novell, Inc.
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